
 

Digital Legacy Lab Storage Recommendations 

GCPL IT Department recommends patrons bring a USB Drive or other storage medium 
with at least 8 GB of available storage to ensure they have plenty of space for any assortment 
of possible files.  

That said, smaller drives are perfectly welcome if the patron knows how much space 
their digitized files will use. Some sample file sizes for typical media files are listed below, but 
keep in mind actual file sizes can vary greatly based on a variety of factors including length of 
media, amount and type of “information” being stored, variations in settings and encodings, 
and many other variables. 

Images 

• PNG ~ 2 – 4 kB 
• GIF ~ 6 – 8 kB 
• JPG ~ 9 – 12 kB 
• TIFF ~ 900 – 1.000 kB 
• BMP ~ 900 – 1.000 kB 

Documents 

• DOCX ~4 – 8 kB 
• PDF ~ 18 – 20 kB 
• ODT ~ 80 – 90 kB 

Media Files 

• eBook ~ 1 – 5 MB 
• MP3 song ~ 3 – 4 MB 
• DVD Movie ~ 4 GB 
• HD Movie ~ 5 – 8 GB 
• Blu-Ray Movie ~ 20 – 25 GB 

Patrons may save their files to DVDs or CDs at all Digital Legacy Lab locations. However, this is not 
recommended as DVDs and CDs hold less storage than a USB drive and are harder to access as optical 
drives are not included in new technology. Patrons will need to migrate the files again soon. 
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Policies and Procedures 
Overall process for accessing the Digital Legacy Lab 

The Digital Legacy Lab is a digitization lab to convert analog forms of media to digital files. Media forms 
that can be digitized are: 

• Vinyl records 
• Audio cassette tapes 
• CDs 
• VHS and VHS-C tapes 
• 8mm film 

• Super8 film 
• DVDs 
• Hi8 video cassette 

tapes 
• Photos 

• Documents 
• Slides 
• Negatives 
• Large format film 

All patrons must sign the Digital Legacy Lab User Agreement before using the lab. This is a digital form 
patrons can sign on the Digital Legacy Lab computer. It is located on the Desktop. 

In-person training is available once a month. It includes an overall explanation of the Digital Legacy Lab 
and the equipment, watching video tutorials, and answering questions. It is not mandatory to attend the 
in-person training. 

Written and video tutorials are available for reference and step-by-step information about the 
digitization equipment. The video tutorials are also available on the Geauga County Public Library 
website. 

The Digital Legacy Lab is completely self-service. Patrons are expected to do all digitization projects by 
themselves or with the help of their own assistant such as a family member or friend. 

Staff assist with troubleshooting issues only. Staff will not help with digitization or stay in the room with 
patrons. 

Patrons are welcome to use the Digital Legacy Lab to access the Adobe Creative Cloud software for any 
purpose. 

The Digital Legacy Lab is free to use and available during library hours. 

Call or talk in-person to any Geauga County Public Library Reference desk to schedule time in the Digital 
Legacy Lab. 

There are four (4) Digital Legacy Labs available: 

• Bainbridge 
o All types 

• Chardon 
o Photos, documents, slides, and negatives 

• Administrative Center 
o Videos, photos, and documents 

• Geauga West 
o Videos, photos, documents, slides, and negatives 
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8mm and Super8 Film Converter Tutorial 

 The Digital Legacy Lab can convert 8mm and Super8 film with the 8mm converter. It is digitized 
slower than real time, about 5x slower than watching the film normally. 

Set up the Machine 

1. Make sure the converter is turned on. 
2. Push the film door tab left to flip open the door. 
3. Mount the Reels and Film. If your film reel has 8mm (small) mounting hole, mount the reel 

directly to the left shaft, otherwise use the provided red color reel adapter 
a. If adapters are needed always place Red on the LEFT side, Grey on the RIGHT side. 

 

b. Mount the included 5” reel to the right shaft. 
c. Route the film according to the diagram on the face of the device.  

 

4. Slide open the flap door, putting the film sprocket holes at the top. Place the film underneath 
the 3 white tabs. 

a. Place and hold film underneath Tab #1 
b. Twist film slightly and clip film underneath Tab #2 
c. Twist film slightly and clip film underneath Tab #3  

5. Make sure the film is placed properly, then close the flap door. 
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6. You can make the adjustment of the Movie Register (the film center X and Y). It needs to be 
adjusted before recording if the default setting is off. 

a. If the image is showing clearly on the screen, skip this step. 
b. Choose Frame ADJ from the Menu and press Enter. 

 

c. Once satisfied with how the image looks on the screen, press Menu to get back to the 
Main Menu screen. 

Recording 

1. Have Record highlighted on the Menu screen. Press the Up and Down button to get to Record. 
Press Enter. 

 

2. Select the film type using the Film Selection Lever, then press Enter/Start button to start 
recording. 

 

a. While recording is in progress, a red dot will blink at the upper left corner. 
b. Each image will show on the screen. 
c. The file counter at the lower right corner will increase by one after each recording stop. 

This number represents the filename of the current recording film. 

Film Selection Lever 
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Rewind 

 

1. Open the flap door and remove film, then close the flap door. Confirm the flap door is not in the 
way of the rewinding process to prevent film from being scratched. 

2. Swap reels. Place an empty reel on the right-side shaft and place film perforation holes on the 
outside (as shown). Use adapters if needed. 

3. Follow the dotted line diagram on the converter, select Rewind in the Menu by pressing the Up 
and Down buttons. Press Enter (press enter again to stop). 

Copy files 
1. Press Menu on the converter and then press the Up or Down buttons to USB(More). Press Enter. 

a. The screen will say “USB Upload.” 

2. Go to File Explorer  on the computer. The converter will show up as a USB Drive (the drive 
letter may change depending on what else is currently running on the computer.  
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3. Click Film Scanner, then MOVIE. Your files are in this folder 

 

4. Plug your USB drive into the computer. 
a. GCPL recommends an 8 GB USB drive or larger to save your files. 
b. All Digital Legacy Labs can save to CDs, DVDs, email, or cloud storage as well, but these 

options are more complicated. 
5. Click and drag the folder of your tracks to your USB drive. 
6. Make sure to delete your files from the converter. 

a. Option 1: Delete the files from the MOVIE folder on the computer. 
b. Option 2: Press Menu on the converter. Press the Up and Down buttons until Format is 

highlighted. Press Enter. Choose Yes with the Up and Down buttons and press Enter to 
delete all files from the converter 

*Files MUST be manually deleted from the converter. They will not automatically delete.* 
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Scanning with the Auto Feeder Scanner 
The Digital Legacy Lab has two types of auto feeder scanners. This will cover both types.  

Auto feeder scanners can scan photographs and documents up to 8.5 x 11 inches. All scans are at least 
high resolution at 300 dpi. 

Table of Contents 

Preparing Photos…… 1 

Fastfoto Scanner……. 2 

Plustek Scanner……… 4 

Preparing Photos 
Before coming to the Digital Legacy Lab, prepare your photos and documents for easy scanning. 

1. Use a soft, dry cloth (like the microfiber cloth, one is available in the Digital Legacy Lab) to wipe 
the front and back of your photos to remove dust, dirt, or other particles that could potentially 
scratch your photos. 

a. Caution: Because of the speed at which photos are scanned, dust particles on your 
photos can cause straight lines to appear in scanned images, and in extreme cases can 
lightly scratch the protective finish on your photos.  

2. Organize your photos by date or subject. 
a. When scanning, you can name the images using the year, month or season, and subject, 

such as "1970_Summer_Vacation". 
b. Organizing the photos can save time in the future. 

3. Check the following if you are scanning various sizes of photos: 
a. If you have both landscape and portrait photos of the same size, you can stack them 

together and scan them in one batch. You can rotate the images as necessary after 
scanning by clicking Edit > Rotate Left or Rotate Right. 

b. You can scan 4×6" and 5×7" photos in the same batch when the photos are grouped by 
size, with the larger photos at the back. 

4. Make sure the photos: 
a. NOT curled 
b. Have NO sticky notes or adhesives on the back 
c. Have staples and paperclips REMOVED 
d. Do NOT stick to each other when shuffled. 

5. Next, place the organized photos into the scanner. 
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Fastfoto Scanner 
The Fastfoto scanner is available at all Digital Legacy Lab locations except Geauga West. If at Geauga 
West, skip to the Plustek Scanner. 

1. Make sure the scanner is on. 
2. Open the input tray, slide out the output tray, and then 
raise the stopper. 

 

a. If you want to scan large size photos such as 5×7" or 8×10", extend the input and output 
tray extensions. 

b. Make sure you adjust the position of the stopper to correctly fit the size of the ejected 
photos. If not, photos may scatter.  

 

3. Slide the edge guides on the input tray all the way out. 
4. Load the photos into the input tray face up and top edge first.  Slide the photos into the scanner 

until they meet resistance.  

 

a. Note: it is recommended to place the photos horizontally. 
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b. If you are loading 4×6" and 5×7" photos in the same batch, align the middle of the 
photos and load them at the center of the input tray with the 5×7" photos at the back 
and the 4×6" photos at the front. 

5. Slide the edge guides to fit the edge of the photos making sure there are no gaps between the 
photos and the edge guides. Otherwise, the photos may be fed skewed. 

6. Click the button on the scanner to start scanning.  (The software will launch 
automatically.) 

7. Set the save settings on the Describe Your Photos screen. 

a. Year/Month or Season/Subject: Set the file name settings. 

8. Click Start Scanning.  
a. Note: If the glass surface dirt alert appeared when scanning, clean the glass surface 

inside the scanner after scanning. 
b. If multiple photos feed through at the same time, press the (Slow Mode) button to slow 

down the feeding speed. Press the button again to return to normal speed. 
9. After scanning is completed, the following screen is displayed:  
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a. If you want to continue scanning, click Scan Next Batch.  
b. When you are finished scanning, click Done Scanning. 

10. The photos are scanned and saved in the folder on the desktop or the location you choose.  
11. Check the scanned images. 

a. The following rules apply to file naming: 
i. No identifier is added: These are the original scanned images. No enhancements 

were applied. 
ii. Added "_a" at the end: These images include automatic color enhancements. 

iii. Added "_b" at the end: These are the scanned back sides of the photo.  
1. You can enable back side scanning from Settings > Scan Settings tab. 

12. After scanning, you can share, upload, or edit the images using the photo scanner. You can also 
change the view setting of thumbnails. 

a. You can rotate the scanned images automatically when scanning using Epson FastFoto.  
i. Click the Settings > Advanced Settings tab, and then enable Auto Rotation.  

ii. Depending on the photos, they may not be rotated correctly.  
1. To rotate the scanned images manually, select the image you want to 

rotate, and then click Edit > Rotate Left/Rotate Right. 

Plustek Scanner 
This scanner is available at Geauga West only. 

1. Turn on the scanner by flipping the switch on the back 
of the machine. 
2. On the desktop, open Plustek DocAction II software.  

 

3. Place your item to be scanned in the scanner. Add up to 
50 pages at a time. 
4. Choose the function you wish to use. These are preset 

settings for using the scanner. 
a. Press the up and down arrows to change between the functions. 

Function File Type Resolution Mode Paper Size 
1 JPG 600 dpi Color Auto 
2 PDF 400 dpi Color Auto 
3 TIFF 600 dpi Color Auto 

b. You can also double-click on the Functions in DocAction II. 
5. The scanner will start scanning. 
6. Once finished, access your files, and place them on your storage device. 
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Cassette Tape Converter Tutorial 
The Digital Legacy Lab can convert standard and CrO2 (chromium oxide) cassette tapes. It is 

digitized in real time. 

Record the Cassette Tape 

1. Make sure the cassette player is plugged into the USB port and turned on. 
a. Find the cable behind the computer marked CASSETTE and plug it into an open port. 

2. Press the Eject button on the cassette player and place the cassette tape into the machine. 
Close the door. 

 

3. Open the Audacity software on the DLL desktop. The Audacity icon looks like this: 

 

4. Press the Record button on the software.  
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5. Press Play on the cassette player. 

 

6. Audacity will begin recording your tape. 

 

a. If you can’t hear the tape playing as it records, make sure the Software Playthrough is 
on. 

i. Click Transport  Transport Options  Software Playthrough (on/off) 
ii. There should be a checkmark next to it. If there is not, you won’t hear the sound 

as it records. 
7. When the tape stops, press the Stop button on Audacity. 
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Save Your New Music File 

1. In Audacity, click File. 
2. Then click Export and export as an MP3 or WAV file. 

 

a. In most cases, you will be fine with an MP3 version. 
3. Save it to your USB or external drive. 

Burn to a CD 

1. Insert the blank CD into the computer using the CD drive. 
2. Left-click and drag to highlight all the files you want to burn to the CD. 
3. Right-click on the files. 
4. Click Send to and choose DVD RW drive. 
5. Follow the onscreen prompts to burn a disc. 
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Hi8 Camcorder Basics 
To digitize Hi8 tapes, the camcorder can play the video through Honestech software. 

1. Make sure the camcorder is plugged into power and plugged into the All-in-One UCEC converter 
device. 

 

a. Plug yellow to yellow, and black to red. White should be left alone. 
2. Turn on the camcorder by pressing the small green tab near the red button and shift the switch 

to PLAYER. 

 

3. Gently push the right side of the camcorder and lift the top section open. 
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4. When the tape deck opens the rest of the way, place the Hi8 tape arrow down into the 
camcorder. 

 

5. Once the tape is in the deck, gently push the deck back. The camcorder will then lower the tape 
deck. 

a. Do NOT push down on the tape deck. 

 

6. Close the lid. 
7. Double-click the Honestech VHS to DVD 3.0 icon on the desktop. 

 

8. The Honestech window will open. 
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9. Click Settings. 
a. Make sure the AV TO USB2.0 is selected for video.  
b. Make sure the audio is Microphone (2-AV TO USB2.0). 
c. Click OK. 

 

10. Press Record and then press Play on the camcorder. 

 

a. The tape will start playing and the software will record. 
b. You should see the video on the screen and hear the audio from both the camcorder 

and computer. 

Where your video 
will be saved. 
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11.  When finished, press Stop on the screen and then stop the camcorder. 
12. Click Edit in the tabs, but this is optional. 

 

a. You can also use Adobe Premiere (video editing software) and Adobe Audition (audio 
editing software), which can be found on the Mobile Memory Lab desktop. 

  

 

13. Click the Burn tab to burn directly to a DVD. 
a. Insert the blank DVD into the DVD drive. 
b. Click Burn. 

Your digitized video 
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14. And/or save your files to a USB drive. 
a. Close or minimize the Honestech window. 

 

b. Double-click the VIDEO FILES folder on the desktop. 

 

i. This is where all digitized files from Honestech are saved. 
ii. If the Video files folder is not there, check the Output Settings under Options 

when on the Capture tab. 
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c. Click and drag your file(s) to your USB drive on the left. 

 

Click and drag 
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Transferring DVDs and CDs 
DVD files are already digital files, but you can transfer or migrate the files to a newer format such as a 
USB drive. There are multiple ways to transfer the files depending on the disc. Review these options and 
choose which one works best. 

Table of Contents 

Click and Drag Files……………………………..….. 1 

Rip a DVD or CD with VLC Media Player…... 2 

Click and Drag Files 

If the files are saved on the CD or DVD like a flash drive, they can be moved easily to a USB drive. This 
process is for homemade CDs or DVDs. 

1. Plug the USB drive into the computer. 
2. Press the button to open the optical drive and place the DVD or CD in the drawer. Close the 

drawer carefully. 
3. Wait as the computer recognizes and reads the disc. 
4. Click on File Explorer. 

 

5. Click on the DVD drive. 

 

6. Click and drag the files to the USB drive. 
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7. Remove the DVD. 
a. Right-click on the DVD or CD drive and choose Eject. 
b. Press the button on the DVD drive and the disc will eject. 

8. Add another DVD and repeat steps 2-8 or remove the USB drive when ready. 
a. Right-click on the USB drive and choose Eject. 
b. Click on the carrot in the bottom right corner of the screen and click on the USB icon.  

 

Rip a DVD with VLC Media Player 

Transferring files from a protected CD or DVD is known as “ripping.” Protected CDs or DVDs are 
copyrighted or burned directly onto the disc and therefore do not allow the previous process for 
transferring the data. 

1. Plug in your USB drive. 
2. Press the button to open the optical drive and place the DVD in the drawer. Close the drawer 

carefully. 
3. Wait as the computer recognizes and reads the disc. 
4. Open VLC media player, which has a safety cone as its icon. 

 

5. Click Media in the top left corner, and then click Convert/Save. 
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6. The Open Media window will appear. Click the Disc tab. 
7. Check the DVD box, and make sure that the “Disc Device” field points to the DVD drive. Click the 

Convert/Save button to rip the DVD. 

 

8. Choose where the file will be saved. Click Browse and find choose your USB drive.  
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a. Add a title for the new file and click Save. 

 

9. Click Start. 

 

10. VLC media player will convert your file. Wait for it to finish. Once the bar has loaded all the way, 
it is done. 
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11. Remove the DVD 
a. Right-click on the DVD or CD drive and choose Eject. 
b. Press the button on the DVD drive and the disc will eject. 

12. Add another DVD and repeat steps 5-10 or remove the USB drive when ready. 
a. Right-click on the USB drive and choose Eject. 
b. Click on the carrot in the bottom right corner of the screen and click on the USB icon. 
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Flatbed Scanner 
The Epson V600 flatbed scanner is great for scanning photographs and documents up to 8x10 inches as 
well as slides, negatives, and large format film. It is great for delicate items and books or scrapbooks. 

Table of Contents 

Scanning Photographs and Documents 

Scanning Slides, Negatives, and Large Format Film 

Scanning Photographs and Documents 
1. Make sure the scanner is turned on. 
2. Open the scanner cover. Make sure the document mat is installed inside the cover.  
3. Place your document or photo facedown on the document table. 

a. When scanning multiple photos at once, position each photo at least 20mm (0.8 inches) 
apart. For a large batch of photos, the auto feeder scanners are recommended. 

 

4. Close the scanner cover gently so that your original does not move. 

5. Click the button on the scanner  to start scanning. The software will launch automatically. 
a. If the software does not open automatically, click on the Epson Scan icon on the 

desktop. 

 

6. Click the ‘Scan’ button in the Scan Software.  



Digital Legacy Lab   
 

Flatbed Scanner 2 
 

a. The default mode should 
be Full Auto Mode. If you 
want to change the file 
type or resolution, try a 
different mode. It is 
recommended to keep it 
in Full Auto Mode. 

7. The flatbed will now scan. If there are multiple images spaced 
correctly, the scanner will recognize them. 

8. The files are saved in a folder on the desktop. Open the file to 
edit the files.  

9. Highlight the files you want to save. Click and drag them to your 
USB drive. 

Scanning Slides, Negatives, and Large Format Film 

 
1. To scan film strips or slides, you need to remove the document 

mat from the scanner cover. This uncovers the transparency 
unit window so your scanner can use it to scan your film or 
slides.  

2. Use a soft cloth to wipe the transparency unit window and 
document table. 

 

3. Insert your media in the holder as shown below:  
a. 35 mm: Remove the top layer of the holder. Place the film inside, then lock the top layer 

over it. 

 

b. Medium format: Open the top layer, slide the medium format into the holder, then 
close the top. 
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c. Slides: Gently place each slide into a spot. Try to have them face the same way. It does 
not matter if any slides are backwards, this can be fixed in editing. 

 

4. Line up the tab on the side of the holder to the matching tab on the bed of the scanner. In the 
example below, tab B should be lined up with the B mark on the scanner. 

 

5. Carefully close the lid to the scanner. 

6. Click the button on the scanner  to start scanning. The software will launch automatically. 
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a. If the software does not open automatically, click on the Epson Scan icon on the 
desktop. 

 

7. Click the ‘Scan’ button in the 
Scan Software.  
a. The default mode should be 

Full Auto Mode. If you want to 
change the file type or 
resolution, try a different 
mode. It is recommended to 
keep it in Full Auto Mode. 

 

8. The flatbed will now scan. If there are multiple images spaced correctly, the scanner will 
recognize them. 

9. The files are saved in a folder on the desktop. Open the file to edit the files.  
10. Highlight the files you want to save. Click and drag them to your USB drive. 
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Microphone Basics 
There are two microphones available in the Digital Legacy Labs. Although different types, they work 

the same. The microphone records in real �me and can be used to record voices, devices, or 
instruments. Create commentary for videos, preserve oral history, or sing a song. 

1. Make sure the microphone is plugged into a USB port. 
2. On the computer desktop, double-click on the Audacity icon. 

 

3. Check the Audio Setup to make sure the microphone is chosen. Many devices are plugged into 
USB ports in the Digital Legacy Lab, this will make sure it records the sound. 

a. Click Audio Setup 

 

b. In the dropdown menu, click Audio Se�ngs. 

 

c. The Playback should be either the speakers or headphones depending on your 
preference to hear the sound. 

d. Under Recording, make sure the microphone is picked. It is one of the following: 
i. Shure MV5 – at Bainbridge 

ii. Array Intel Smart – at the Administra�ve Center 
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e. Click OK 
4. To start recording, click the red circle. 

 

5. Record the audio. 
6. When finished, press the black square. 

 

7. To replay the audio, press the green triangle. 

 

8. To trim the audio, click and drag to highlight the area you want to keep. Then press the Trim 
buton. 
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Before and a�er clicking the Trim buton. 

Save your Audio 

1. Click File, then Export and then Export as MP3. 

 

2. Save directly on to your USB drive by clicking This PC and then under Devices and drives, locate 
your USB drive. Note: if may not be called USB drive depending on your device. 

a. Click Open. 
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3. Change the name of the file to make it easy to recognize by typing on the keyboard. Click Save. 
a. In this example, the file name changed from “un�tled.mp3” to “Audio Example 2023” 

 

4. Add metadata if desired. This informa�on is stored with the mp3 file. This is op�onal. Click OK. 

  

5. Your file is saved. 
6. Repeat these steps for any audio you create. 
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Slides and Negatives Scanner 

Easily convert your slides, negative, and Super 8 frames to digital images that you can store and 
preserve. 

 

1. Function Keys (soft keys): The function is indicated by the 
text that will appear on the screen above the 
corresponding key. 

2. Power On/Off Button: Press and hold to turn the device 
on and off 

3. Capture Button: Captures the image or brings up the 
capture view screen 

4. Tilt-up LCD Screen: Displays the image to be captured and 
scanned as well as functions and menus. 

5. Home Button: Takes you to the Home screen. 

 

Preparing Media to Scan 

Load your film/slide into the appropriate adapter and insert according to the Tray Directory 
below (can also be found on the scanner: Home>Settings>Film Tray). 

Each adapter tray and insert is clearly marked and numbered. 
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Tray Directory 

Film Type Adapter Needed Insert Needed 
Negative Color Negative 135 No. 2 None 

Color Negative 126 No. 1 None 
Color Negative 110 No. 2 No. 5 

Slide Slide Positive 135 No. 1* None 
Slide Positive 126KPK No. 1* None 
Slide Positive 110 No. 1* No. 6 
Slide Positive Super 8 None No. 4 
Slide Positive 8MM None No. 4 

Black & White Black & White 135 No. 2 None 
Black & White 126KPK No. 1 None 
Black & White 110 No. 2 No. 5 

*Note: Use adapter #3 for slides with a thicker casing (plastic). Use adapter #1 for slides with a 
thin cardboard casing. 

Slides 35mm 110 110 126 127 
Mount 2” x 2” 2” x 2” 1” x 1” 2” x 2” 2” x 2” 
Film Size 24 x 36mm 13 x 17mm 13 x 17mm 28 x 28mm 40 x 40mm 

 

1. Flip up the top cover of the adapter.  
2. Place the slide or film into the adapter. Line up the slide with the opening. 
3. Snap the adapter closed. 
4. Place the insert with your slide or film into the adapter. 

Capture 

1. Turn on the scanner by pressing the Power On/Off 
Button. 

2. Choose “Capture” by pressing the middle function key. 
a. The loaded image will appear on the screen. 

3. Press the Capture Button (camera icon) to capture and 
save an image. The screen will display “Saving…” 

4. Feed more slides into the scanner or shift the film until the next image appears. 
5. Continue steps 3 and 4 until all images have been scanned. 
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Upload 

To save your digitized images to your USB drive, you must upload the files from the scanner to 
the computer. 

1. Go to the Home Menu and press the right function key until it reads “USB Upload.” 
a. Press the center function key to select. 

 

2. Wait for the scanner to connect to the computer. This may take a few seconds. When 
connecting, the computer will recognize the scanner as an external device. 

3. Go to File Explorer and locate the new drive that appeared. 

 

4. Click the folders until you find your images. 
5. Highlight the images you would like to transfer. 

a. Click and drag the files to your USB drive. 
b. Check that they are on your USB drive. 

6. Delete the files from the Kodak Scanner 
a. THEY DO NOT DELETE AUTOMATICALLY 
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VHS and DVD Conversion 
Use the adapter to connect to the VCR, camcorder, or DVD player at specific locations. The Digital 
Legacy Lab can convert VHS, VHS-C and DVDs. 

Table of Contents 

Recording a VHS or DVD….. 1 

Save your Video Files…….... 3 

File Too Large to Save………………. 4 

Burn to a DVD with Honestech…. 6

Recording a VHS or DVD 
1. Make sure the VHS player or DVD player is plugged into the All-in-One converter and turned on. 

 

a. This is the converter. Connect each plug to the matching plug on the chord attached to 
the VHS player or DVD player. 

i. Red to red, yellow to yellow, and white to white. 
ii. The other end (USB connection) should be plugged into the computer. 

2. If the VCR or DVD player starts playing, press STOP for now. 
3. Double-click the Honestech VHS to DVD 3.0 icon on the desktop. 

 

4. If prompted, enter the product key for the software. If not prompted, skip to the next step. 
a. Bainbridge: VHS3G-FWL9G-G8HG7-F245B-78WG7 
b. Geauga West: VHS3G-FWL9G-G9688-G2C5B-77W87 
c. Video DLL: VHS3G-FWL9G-G7668-G225B-85W68 

5. The Honestech window will open. 

 

6. Click Option. 
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a. Make sure the AV TO USB2.0 is selected for video.  
b. Make sure the audio is Microphone (AV TO USB2.0). 
c. Click OK. 

 

7. Press Record on the Honestech software and then press Play on the VHS player or DVD player. 
a. The tape will start to play and the software will record. 
b. You should see the video on the screen and hear the audio. 

  

8. When finished, press Stop on VHS or DVD player and then Stop in the Honestech software. 
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9. Rewind your VHS tape and eject it from the VHS player. Eject the DVD from the player. 
10. Insert a new VHS or DVD to record another video. 
11. When finished, save your files to a USB drive, or burn them to a DVD. 

Save your Video Files 
Geauga County Public Library recommends saving your files to a USB drive (also known as a flash drive 
or memory stick) with at least 8GB of storage data. USB drive come in many sizes, so choose the size 
best for your projects and budget. 

1. Close or minimize the Honestech window.  

 

2. Double-click on the Video Files folder on the Desktop. 

 

a. If you changed the save location in the Honestech Options, locate that folder instead. 
b. Files might be saved to the Documents folder in the File Explorer. 

i. Click on File Explorer in the taskbar.  
ii. Click Documents 

iii. Click on the VHS to DVD folder. 

 

3. Highlight the files you want to save by clicking and dragging the cursor over them. 
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4. Click on the highlighted area and drag your files to your USB drive on the left. 
a. If the files are large, try saving one at a time. 

 

File Too Large to Save 
If an error message appears that says the file is too large to transfer to your USB drive, but there is 
enough space on the drive for your file, follow these steps. 

For example, you have a 8GB USB drive and a 5GB video, but the computer says it can not save the file 
because it is too big. 

1. Open the location of the video files in File Explorer.  
a. Either open Video Files on the Desktop or VHS to DVD folder in the Documents Folder. 

 OR  

2. Click Home and then New Folder to create a new folder. 

 

Click and drag 
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3. Rename the new folder 

 

4. Click and drag around the files you want to save to your USB drive. This will highlight them. 

 

5. Click on the videos and drag them into the new folder. 

  

6. Right-click on the folder. A menu will appear. 
a. Click 7-Zip 

 

b. Then click Add to “Videos.zip” 
i. NOTE: it will not say “Videos” unless that was the name of the folder you 

created. It will say your folder name. 
7. The computer will make a zipped folder. 
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8. Click and drag and new zipped folder to your USB drive. 
a. A zipped folder has a zipper on it. 

 

Burn to a DVD 
There are multiple ways to burn a DVD. Here are the directions to burn a DVD in the Honestech 
software. 

1. After recording the video(s) you want to burn to a DVD, click the Burn tab. 
2. Click and drag the files on the right side of the screen to the middle of the software.  

  

Click and drag 
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3. This will create a default menu that you can edit. 
a. Double-click on the title to type in a new title 

 

b. Double-click on each file name under each video to change the name of each individual 
video and organize the videos. 

    

c. If you do not want an automatic menu, uncheck the box next to “Create menu.” The 
screen will change to this. 
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4. Insert the blank DVD into the computer. 
a. Wait until the computer recognizes the blank DVD. This may take some time. 
b. If the DVD is not recognized, try ejecting and re-inserting the DVD. 

5. When ready, click Burn in the Honestech software. 
6. The videos will be burned to the DVD and will be playable in a DVD player. 

 

7. Eject your DVD from the computer. 
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Vinyl Record Converter Tutorial 

 The Digital Legacy Lab can convert 33 1/3, 45, and 78 rpms. It is digitized in real time. 

1. On the computer, open the EZ Vinyl/Tape Converter software 

 

2. Make sure the vinyl record machine is plugged in via the USB cable and turned on. The cable will 
be marked VINYL. Check and make sure the cassette player is unplugged. 

 

3. Place the vinyl record on the machine. Press the Start button. 

 

a. Press 33 for 3 1/3 rpm, the 45 for 45 rpm, or both 33 and 45 for 78 rpm. The record will 
say what type it is on the label. 
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4. Place the needle on the outside edge of the record as it spins. 
a. The record starts to play. 

 

5. Now get the music ready to play by setting the levels. 

 

a. The gain slider controls how loud the final recording will be. 
i. Test the levels by pressing PLAY on the cassette player. Watch the levels and see 

how high the sound goes. DO NOT PRESS RECORD AT THIS TIME. 
ii. You want the sound to stay in the upper third of the level. Not into the red, but 

it can be close to it. 
iii. If the levels are too high, the sound will be distorted. If it is too low, you will not 

be able to hear the sound. 
iv. Move the slider to the left of the levels to raise or lower the gains. 

b. The software will automatically recognize different tracks by detecting silence. 
i. If it is not doing this, make sure the checkbox is checked. Otherwise you will 

manually separate the tracks. 
6. Once satisfied with the sound, lift the needle off the record. 
7. Press RECORD in the software. Then place the needle back at the edge of the record. 

 

Gains slider 

Upper Third 

Levels Automatically 
split tracks 
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a. You should be able to hear the music and see the levels on the software as it plays. 
i. Check the Troubleshooting part of this tutorial to see why there may be no 

sound. 
8. Once finished, lift the needle from the record and return it to its holder. Then press NEXT on the 

computer. 

 

9. Add the Artist, Album, and Track title information on this page. It will give you the chance to 
name each track. 

a. This information is helpful when you go to listen to it later. 

 

10. Click NEXT on the computer to either move to the next track or for the next step when all tracks 
have been named. 

11. The next window appears: 
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a. Record Something Else: to record the other side of the cassette or another tape. 
b. Open Save Location: to move your new audio files to your USB drive. 
c. Close EZ Vinyl/Tape Converter: to close the software. Your files are still saved in the 

location. 
12. When ready to move your files to the USB, click “Open Save Location.” 

 

13. Plug your USB drive into the computer. 
a. GCPL recommends an 8 GB USB drive or larger to save your files. 
b. All Digital Legacy Labs can save to CDs, DVDs, email, or cloud storage as well, but these 

options are more complicated. 
14. Click and drag the folder of your tracks to your USB drive. 

 

15. Make sure to take all records and your USB drive when you leave. 
a. The computer will erase all data after you log out. 

 

 

 

 

 



Digital Legacy Lab   
 

Vinyl Record Converter Tutorial 5 
 

Troubleshooting 

Problem Cause Solution 
Recording sounds loud and 
distorted The gain level is too high Option 1: Slide the gain slider 

next to the levels. 
Option 2: Turn the gain knob on 
the cassette player. Recording is barely audible The gain level is too low 

Cannot hear the recordings 
once transferred and trying to 
play them on the computer Computer audio output not set 

correctly. 

Access the Control Panel and go 
to the Sound settings. Click the 
Playback tab and make sure the 
computer’s soundcard is the 
chosen device. 

While the USB device is 
connected, can’t listen to any 
music from the computer 

Recordings are mono instead of 
stereo 

Recording input properties not 
set to “stereo” 

May need to manually specify 
“stereo.” Go to the Control 
Panel and choose Sound. Click 
the Recording tab and highlight 
the Microphone input (USB 
Audio Codec). Click on 
Properties to bring up the input 
settings. Click on the Advanced 
tab and select 2 channel, 16 bit, 
44100 Hz (CD quality) in the 
Default Format pull-down 
menu. Click Apply to accept the 
settings. 

The sound from the USB 
device’s audio outputs is 
distorted or full of static 

Line/phono level switch may 
not be set properly. 

Check the line/phono switch on 
the vinyl record player and 
make sure it is set to the 
appropriate level for the inputs 
connected. 
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Saving Files to a CD or DVD 
Save your files by burning on to a CD or DVD. The pictures show for a DVD, but it is the same process for 
a CD. 

1. Press the button to open the optical drive and place the DVD in the drawer. Close the drawer 
carefully. 

2. Wait as the computer recognizes and reads the disc. 
3. Click on the prompt that appears in the bottom right corner. 

 

a. Click Burn files to disc. 

 

b. This will open the Burn a Disc window. 
4. If the prompt does not appear, Click on File Explorer 

 

a. Double-click on the blank DVD which should have appeared. 

 

i. This will open the Burn a Disc window. 
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5. Type a title for your disc (default is the date). This is optional.  

 

6. Select how you want to use the disc.  
a. Like a USB flash drive: save, edit, and delete files on the disc at anytime.  

 

i. Click Next 
ii. Find the files you want saved on the CD or DVD. 

1. These could be on the Desktop in one of the folders, or in the 
Documents or Videos folder. It depends on the equipment you used to 
digitize the files. 

iii. Select the files to be added to the disc. Click and drag them to the CD or DVD 
drive icon on the left.  
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iv. Click the CD or DVD icon to confirm the files transferred to it. 
v. You can now eject the disc. 

b. With a CD/DVD player: burn files in groups and individual files can’t be edited or 
removed after burning. 

 

i. Click Next in the Burn a disc window. The disc formatting process begins. 

 

ii. Find the files you want saved on the CD or DVD. 
1. These could be on the Desktop in one of the folders, or in the 

Documents or Videos folder. It depends on the equipment you used to 
digitize the files. 

iii. Select the files to be added to the disc. Click and drag them to the CD or DVD 
drive icon on the left. 
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iv. The files display in a Files Ready to Be Written to the Disc window. 

 

v. Right-click the empty area or on the CD or DVD disc on the left-hand side. Click 
Burn to disc. 
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vi. Type a title for your disc (default is the date). This is optional.

  
vii. Click Next.  

viii. The files will now be burned to the disc. 

 

ix. Click Finish to close the window. You have successfully burned your files to the 
disc, and it can be ejected. 

 



Saving to a ZIP file 

If the computer says your file is too big to transfer to your USB drive, follow these steps. 

The cause of this error is to transfer files on to a USB drive, you use flash memory. While the USB drive 
may contain 8 to 32GB of storage space, the flash memory might be able to move 2 to 4GB at a �me 
depending on the USB drive. It is like packing your things into a moving truck – while your home is more 
than big enough to fit everything, you must first pack your items into boxes and place them on a much 
smaller truck to get everything there. The flash memory is the truck in this example. The boxes are the 
zip file where you can pack and compress your file to move it. 

1. Locate your files on the computer. This may be in a different folder depending on the machine 
you used to digi�ze. 

a. You are opening File Explorer. 
2. At the top of the window on the Home tab, click New Folder. 

a. You can also right-click in the space next to the files and click New then Folder in the 
menu that appears. 

 

OR 

 

3. Name your file to something you can recognize. The �tle is already highlighted (selected), so 
simply start typing on the keyboard. When finished, press the Enter buton. 

4. Click on the files you want to put on the USB drive. Drag them into the new folder. 
5. A�er all files are added, right-click on the mouse to open the menu. 
6. Click Send to and then choose Compressed (zipped) folder. 



a. The new zipped folder will appear. 

  

7. Click and drag the new zipped folder to your USB drive. 
8. To unzip the folder in your USB drive, right-click on the folder. 
9.  
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